
2 DATA ENTRY/QUERY/


UPDATE/OUTPUT 


Accessing Data Entry Screens 
The data entry application allows you to: 

P add new reports to the database P print reports

P query and update existing reports P transmit reports


To access the data entry application, choose the UI Required Reports -
JAM Version menu option. In the UI Required Reports - JAM Release 4.0 
menu, choose Data Entry, Query, Update & Transmit. The Reports 
menu appears displaying the following categories of reports: 

P Claims Activity, Regular P Special Programs

P Claims Activity, Extended P Benefits Timeliness Reports


Each of these categories contains one or more individual reports. Choose one of 
these categories to display individual report option(s), as shown in Figure 2.1. At 
the bottom of the screen the following message appears: 

Machine loading screen arxxxx, please wait... ;

where xxxx represents the report number.


Figure 2.1 
UIRR Menu 
Options 
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Data Entry Screen 
When you choose a report, the Data Entry screen for the report is displayed 

along with a message window, as shown in Figure 2.2. Press Z  or click 
on OK to close the message window. 

Figure 2.2 

Sections of the Data Entry Screen 
The Data Entry screen consists of a series of parts. This section explains these 
parts, beginning from the top of the screen. (See Figure 2.3.) 

P	 Title bar. Displays the alphanumeric name of the table used to store 
the report data (example, ar218). 

P	 Menu bar. Displays menu and sub-menu options that enable you to 
perform the report functions. The menu options include: 

P Database P Validate P Output 
P Edit P Transmit to N.O. P Help 
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P	 Title. Displays the report’s full title (example, ETA5159 Claims & 
Payment Activities). 

P Header Section. Contains information identifying the report, such as: 

µ Date for Period Ending — This date is always the last day of the 
report period 

µ State and Region — The State version always displays your State 
and Region 

µ Creation Date — The date the report was created 
µ Revision Date — The date the report was last updated 
µ Transmit Date — The date the report was first sent to the National 

Office 

P	 Data Section. The largest part of the Data Entry screen. You enter or 
modify data in the data fields in this section. 

P	 Comments Section. The last section of the Data Entry screen. It 
displays a text area of up to 20 lines of text for you to enter comments, 
when appropriate. 

You can navigate through these various sections of the Data Entry screen in 
several ways: 

P With your left mouse button either drag (move) the scrollbar (right 
side) or click on the scrollbar column. 

P Press the PageUp/PageDown keys. 
P Press the Up/Down(UV) or Left/Right (ST) arrow keys . 
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Database Menu 
The Database Menu contains a submenu, as shown in Figure 2.4. 

Figure 2.4 
Database 
Submenus 

The functions within this submenu are: 

P Query	 Searches for one or more records that have been saved in the 
database. After you use the Query mode, you can access the 
following submenu options: 
� Next Displays the next record in chronological sequence. 
� Previous Displays the previous record in sequence. 
� First Displays the first (earliest) record in sequence. 
� Last Displays the last (most recent) record in sequence. 

P Add Adds a new record to the database.

P Update Allows updating of the record currently displayed on the screen.

P Save  Saves the currently displayed report to the database. Available


only in Add and Update modes. 
P Cancel Cancels the current operation. Available only in Add and Update 

modes. 
P Exit Exits the data entry application. 
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Adding a New Report 
To add a report to the State’s database, you need to do these steps: 

P Identify the report period

P Enter data in the Data Section

P Enter comments, when applicable 

P Validate the report

P Save the report


Identify the Reporting Period.  Choose Add from the Database menu. Awindow is displayed, as shown in Figure 2.5. 

Figure 2.5 
Repor ing 
period date 
window 

Report for Period Ending: The reporting period is the last day of 
the period to which a report pertains. Each report has its own reporting 
period or cycle: weekly, monthly, quarterly, or annually. The report 
date is always the last day of the report period (example, if the first 
quarter of a quarterly report begins on 01/01/1997, its report date 
would be 03/31/1997). Note: A few reports have data referring to 
periods of time in the future so the report date will be in the future. 

Generally, a date will be displayed for the next report that is due. This 
default date may be overridden. 

Type the ending date of the period covered for the report you want to 
add (example, 03/31/1996 for a first quarter report). 

State: The State entry area displays the two-letter abbreviation of 
your State (example, MI for Michigan) and cannot be changed. 
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There are three pushbuttons at the bottom of the screen — Ok, Cancel, and 
Help. 

P Ok	 Prepares the Data Entry screen to receive the report date. If 
the report has been created already, a message window 
displays, Record already exists! 

P Cancel	 Exits the Add report process and returns to the Data Entry 
screen. 

P Help Displays information about the report date screen. 

If your report date is valid, after choosing Ok, you are returned to the Data 
Entry screen. Notice that the header now displays the following 
information: 

P the Report Date you entered (example, 06/30/1996)

P your State’s two letter abbreviation (example, MI)

P your Region (example, 05)

P the Date and Time you entered the report (example, 08/20/1996 11:45)


Data Section 
You’re now ready to enter information in the data fields of the Data 
Section. To enter data in a field, you need to highlight it. It can be 
highlighted several ways: 

P Use the tab key to position the focus on a field. 
P Click on the field with the mouse button. 
P Press the Up/Down (UV) arrow keys to navigate vertically through 

the fields, and press the Left/Right (ST) arrow keys to navigate 
horizontally through the fields. 
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Tip: To get help about the information you need to enter in a specific data 
field, highlight the field, then: 

P Press A, or 
P Choose the Help menu, then choose the Context Help option. 

(For more information about this option, see the section on 
“Getting Help On-Line”, Chapter 1, Getting Started.) 

Comments 
At the bottom of the data entry screen is a Comments text entry window, as 
shown in Figure 2.6. This window enables you to enter or edit comments 
regarding a report. To enlarge the window into a full screen to make text 

entry and editing easier, press E or click on the Zoom pushbutton. 

Figure 2.6 
Comments 
window 

When you enlarge the Comments section, you can see the entire 20 lines of 
available text area, as shown in Figure 2.7. 
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Figure 2.7 
Zoom 
Comments 
window 

At the top of the Comments section are buttons that allow you to edit your 
Comments. To edit, the text must first be blocked (highlighted). 

To block text, move the mouse to the first character of text you want to block. 
Hold down the mouse button and drag the pointer to the last character you want to 
select, then release the mouse button. To select a paragraph, double-click the 
mouse button. Once the text is blocked, you can choose one of the following 
edit options at the top of the zoom Comments section: 

P Cut	 Moves a block of text from the Comments section to the clipboard, 
then you can paste the text elsewhere in the Comments section after 
you position the cursor.{ 

P Copy	 Copies a block of text in the Comments section to the clipboard, then 
you can paste the duplicate text elsewhere in the Comments section 
after you position the cursor. 

P Paste 	 Inserts a block of text from the clipboard in the Comments section 
at the cursor location. 

P Delete Deletes a block of text without inserting it into the clipboard. 

{ A clipboard is a temporary storage area of memory where cut or copied text is stored 
until you paste it elsewhere. 
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Please note, that the double quotes character (e.g. “) does not work properly 
in the Comments section. 

At the bottom of the zoom Comments section, there are the following buttons 
— Ok, Cancel, and Help. 

P Ok	 Saves your changes in the Comments section, closes the zoom 
Comments window, and returns you to the Data Entry screen. 

P Cancel	 Cancels the changes made in the Comments section since the 
report was last saved to the database and returns you to the 
Data Entry screen. 

P Help Displays information about using the zoom Comments section. 

If you choose Ok and then choose the Save option in the File menu, the 
system scans the report for warnings and/or errors. If the report contains 
warnings or errors, a List of Edits is displayed, as shown in the sample in 
Figure 2.10. 

Since you cannot transmit reports with errors, you must correct them. To do 
this, press the Edit Data pushbutton at the bottom of the List of Edits to return 
to the Data Entry screen. To edit data with errors, highlight the field by 
clicking on it with the mouse or navigate to it by pressing the up/down (UV) 
or left/right (ST) arrow keys. 

If you need information about the type of data to enter in a field, highlight the 
field, then press A or choose Context Help from the Help menu. A screen 
displays information about the selected field. 

If the cause of the error is not known and must be researched, the data can be 
saved and called up for correction later. However, as noted above, reports 
with errors cannot be transmitted. 
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Querying Reports 
To query for a report is to have the system look in the database for one or 
more saved records of a report specified. To query record(s), choose the 
Query option from the Database menu. A Query screen appears, as shown in 
Figure 2.8. 

Figure 2.8 
Query Screen 

P	 Click on the pushbutton to the right of EQUAL TO, which then displays 
the following options: 

EQUAL TO


GREATER THAN


LESS THAN


OTHER


Displays the report whose Report Date is equal to 
the date you enter (example, 06/30/1997). 

Displays all reports in the database whose Report 
Date is greater than the date you enter  (example, 
06/30/1997). 

Displays all reports in the database less than the 
date you enter (example, 06/30/1997). 

Allows you, if you’re familiar with ISQL, to enter 
the where clause for the Query. 

P Type a report date (example, 06/30/1996) in the top right rectangle. 
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Searching Queried Reports 
At the bottom of the Query screen are the following buttons: 

P Ok 	 Begins the retrieval search for the records with the date range 
you specified. 

P Cancel Cancels the Query process. 

P Help Displays information about the Query screen. 

Displaying Queried Reports 
When you click on Ok, the data entry screen displays the report with the earliest 
report date in the range you specified. After the first report is shown, you can 
switch to other reports retrieved using the following options: 

P Next Displays the report with the next chronological date. 

P Previous Displays the report with the previous date. 

P Last Displays the report with the latest date. 

P First Displays the report with the earliest date. 
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Outputting (Saving/Viewing/Printing) a Report 
The Output menu allows you to view, print, or save a report to a file. To access a 
report via the Output menu, the report must have already been saved. When you 
choose the Output option, a report is displayed, as shown (partially) in Figure 2.9. 

Figure 2.9 
Example of 
Output Screen 

At the bottom of the report there are the following pushbuttons: 

P Save As	 Allows you to save a file with a new file and/or path 
name. 

P System Printer Prints the displayed report on your system printer. 

P Local Printer Prints the displayed report on your local printer. 

P Exit	 Quits the Output screen and returns to the Data Entry 
screen. 

P Help Displays information about the Output screen. 
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Unique Reports 
While all UIRR reports follow the same general formats and procedures, the 
following reports have special features or requirements: 

P ETA 191 P ETA 902 

P ETA 204 P ETA 8400 banking series

P ETA 205 (arertx) P ETA 9056 and ETA 9057 Quality Reports


Of these reports, only the Quality reports are currently available in graphic 
user interface (GUI) mode. The other reports are still in character-based 
mode. As they become accessible in GUI mode, a discussion of the qualities 
that make them unique will be issued. 

Quality reports are: 

ar 9056 - Nonmonetary determinations quality report 
ar 9057 - Lower authority appeals quality report 

They are unique because: 

P There are multiple entries for each time period.

P These reports represent a sample.

P Data for each sample record is entered at two different points in time:


case identifying data and then scoring data. 
P The system scores the result and provides an overall score for your 

State 

For more information about Quality reports, see Chapter 6. 

42



Chapter 2 

Updating a Report 
The Update options allows you to change data in a report that was 
previously entered. To make data change(s), click on the Database menu, 
then choose the Query option to retrieve the report. (See the Query section 
in this chapter for details.) 

When the report is displayed, access the Update mode by pressing Nu, 
or click on the Database menu and choose Update. 

The first data field is highlighted. (To get an explanation of a data field, 
highlight the field with the cursor, then click on the Help menu and choose 
Context Help.) Click on the data field to be changed and retype the correct 
information. 

Validating a Report 
The Validate option searches for errors and warnings in the currently 
displayed report. When you choose the Validate option, two submenus appear 
— Check for Errors and Switch to Edit, as shown in Figure 2-9. 

Figure 2-9 
Validate 
Menu 
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Checking for Errors 
This option checks for errors and warnings in the currently displayed report. If 
errors or warnings are found, a Review-Edit screen appears with a list of edits. 
See the sample shown in Figure 2-10. 

Figure 2.10 
List of Edits 

The top section of the Review-Edit screen displays the report’s table name, 
reporting date, and the State. 
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The middle section displays one or more of three types of errors — fatal 
errors, errors, and warnings — and a description of them. Each type is 
described below: 

P	 Fatal errors.  The system builds in safeguards to prevent fatal 
errors; nonetheless, the system checks for them. Fatal errors will not 
allow a report to be saved. 

Example: If a Michigan data entry user somehow entered 
Minnesota’s state abbreviation as the State designation, a fatal error 
would occur. 

P	 Errors.  These are generally math errors, but may also be impossible 
entries. 

Example: Assume two fields are supposed to add to a third field. If 
the program checks the two fields and finds they don’t add to the 
third field, it is considered an error. 

P	 Warnings.  Warnings occur when expected relationships between 
two or more items in a report are not found. 

Example: The value in field c2 is usually less than the value in field 
c1. Other edits compare the value of a field with: 

µ the value of the comparable field in the immediate prior period, 
and 

µ the average value of the comparable fields for the same period 
in the immediate prior three years. 

If there is a significant discrepancy, a message is generated. 

Valid data generally pass these “reasonableness” tests. However, 
data can fail these tests. Whendata fail an edit, a warning message 
appears similar to the following example: 

End of review edits -- Report does contain

WARNINGS

but can be transmitted.
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When a warning message appears, check the numerical values. If the 
numbers are correct, the report can still be sent to the National 
Office. 

Tip: If you send reports to the National Office with warnings, an explanation 
in the Comments Section will prevent unnecessary questioning of the 
data by the National Office. 

The bottom section of the List of Edits (Figure 2.11) displays a message 
indicating whether the report (record) can be saved and/or transmitted, plus 
the following pushbuttons: 

P Edit Data	 In the Update mode, choose this button after 
highlighting an error or warning message with your 
cursor. The Data Entry screen will be displayed with 
the cursor automatically on one of the fields 
corresponding to the error or warning message. 

P Switch Screen	 Displays the Data Entry screen so you can edit the data. 
If there is more than one error or warning to correct, 
after correcting the first error/warning, click on the 
Switch to Edit option in the Validate menu. This will 
redisplay the Review-Edit screen so you can see the 
remaining error(s) and/or warning(s) that need to be 
corrected. 
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P Save As Saves error and warning messages to a file. When 
you choose this pushbutton, a screen appears, as 
shown in Figure 2.11. 

Figure 2.11 
Save As 
window 

A default directory appears in the text box opposite Save As:. 
You may accept or change the default directory.  You must add a 
filename. Click on OK to accept the path and filename of your 
choice. Click on Cancel if you don’t want to save the error/warning 
messages as a file. Click on Help if you want information about the 
Save As window. 
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P System Printer	 Sends the displayed Review-Edit report to your 
system printer. If the print job is successful, a 
message will inform you of this, as shown in Figure 
2.12. 

Figure 2.12 
Print message 

P Local Printer Sends the displayed report to your local printer. 

P Help Displays information about the Review-Edit screen. 
window. 

P Exit Exits the Review-Edit screen and returns you to the 
Data Entry screen. 
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